1.3.2C. Sample project report, field report and
documents of internship.
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ABSTRACT

This abstract presents a cryptocurrency web application “DCash™. It is designed to revolutionize the way
individuals engage with digital currencies. Leveraging the power of blockchain technology, the application
provides users with a secure, transparent, and decentralized platform for conducting cryptocurrency
transactions. Users can create wallets, securely store their assets, and seamlessly execute transactions with
minimal fees and fast processing times. The application incorporates advanced security measures, such as
encryption, multi-factor authentication and Gossip Based Byzantine Fault Tolerance algorithms, to protect user
funds and personal information. With a user-friendly interface and intuitive features, this cryptocurrency web
application aims to empower individuals to participate in the exciting world of cryptocurrencies and unlock
new possibilities for financial transactions in the digital age.
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1. INTRODUCTION

DCash is an exciting cryptocurrency web application developed aiming to provide a comprehensive

platform for users to engage with digital currencies. With the increasing popularity and significance

of cryptocurrencies in the financial landscape, Dcash offers an opportunity to explore and understand

this emerging technology in a practical and hands-on manner. Our project endeavors to showcase the

potential of cryptocurrencies and their underlying blockchain technology, while also highlighting the
importance of security, transparency, and usability in the realm of digital finance.

Dcash offers a user-friendly interface, making it accessible to both cryptocurrency enthusiasts and beginners.
Through the application, users can create their own digital wallets, securely store their cryptocurrency assets,
and execute transactions seamlessly. This provides a valuable learning experience, as users can gain insights
into the mechanics of blockchain-based transactions, such as address generation, transaction verification,

and the concept of decentralized ledgers.

One of the key objectives of our project is to emphasize the significance of security in the world of
cryptocurrencies.

We have implemented robust encryption techniques and multi-factor authentication to ensure that user funds and
personal information is safeguarded against potential threats. By incorporating these security measures,
we aim to instill confidence in users and promote responsible practices when engaging with digital assets.
Dcash not only serves as a learning tool but also as a platform for experimentation and innovation.
In conclusion, Deash is an ambitious project that provides a practical and engaging platform for users to explore
the world of cryptocurrencies. By emphasizing security, transparency, and usability, we aim to contribute to
the ongoing dialogue surrounding digital finance while offering a valuable educational resource

for our community.
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1.1 Domain Description:

This software is Website Based. A website is easily accessible across platforms and
can be easily shared among users, as well as search engines. It has far greater reach
capability than any other platform. This Website has been developed using HTML,
CSS, Python, MySQL that most developers are intimately familiar with.

The reason, Website rules the software market is its ability to run on more devices
than its competitors. The simple reason being that a website will be used by more
people, owing to the ‘affordability’ part. Thus, Website development is proved to be
wiser and a more profitable option.

We can open a website from any web browser, not just Google Chrome. In addition,

website is very much user friendly. All of this makes the website available to a larger
number of users and is a major reason to invest in a website development platform.

4+ Hardware Requirements:

PCWITH 250GB HARD DISK

PC WITH 1GB RAM

4+ Software Requirements:

Operating System Windows10
Language HTML, CSS, Python, MySQL
IDE Visual studio code and notepad
Browser Google Chrome
i'g n.P.d i ‘wa
Lepartment of Computer Scicnce EM.Byp: - .. s
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1.2 Motivation:

Imagine a world where financial transactions are instant, secure, and accessible to anyone, anywhere. A world
where individuals have complete control over their money, free from the constraints of traditional banking
systems. This vision of a decentralized financial future is what motivates us to build a cryptocurrency web
application.

We are captivated by the potential of cryptocurrencies to disrupt the status quo, empowering individuals and
revolutionizing the way we think about money. The current financial system is burdened with intermediaries,
complex processes, and hidden fees that disproportionately affect those who are unbanked or underserved by
traditional banking institutions. It's time for a change, and we believe that cryptocurrencies hold the key.

By developing a cryptocurrency web application, we seek to democratize access to financial services

and put the power back into the hands of the people. We envision a future where anyone with an internet
connection can create a digital wallet, transact securely, and participate in the global economy. No longer will
individuals be subject to the limitations imposed by borders or lengthy verification processes. Cryptocurrencies
transcend these barriers, offering a borderless and inclusive financial ecosystem.

The potential for innovation within the cryptocurrency space is boundless. With the introduction of smart
contracts, decentralized applications, and tokenization, we have only scratched the surface of what can be
achieved. By building our web application, we aim to contribute to this ongoing evolution and be at the forefront
of this technological revolution.

But our motivation extends beyond the practical and transformative aspects of cryptocurrencies. It is rooted in a
deep belief in the power of decentralized networks and the principles of trust, transparency, and autonomy. We
envision a future where financial transactions are conducted peer-to-peer, removing the need for intermediaries
and creating a level playing field for individuals around the world. This vision drives us to build a cryptocurréncy
web application that encapsulates these ideals.

Of course, we acknowledge the challenges ahead. Cryptocurrencies are still relatively nascent, and there are
hurdles to overcome in terms of scalability, regulatory frameworks, and mainstream adoption. However, it is
precisely these challenges that make the journey exhilarating. We are motivated by the opportunity to contribute
to the development of solutions, to collaborate with like-minded individuals and organizations, and to be part of a
global movement that is reshaping the future of finance.

In conclusion, our motivation to build a cryptocurrency web application from a passion for creating a fairer, more
inclusive financial system. We are driven by the belief that cryptocurrencies have the power to empower
individuals, disrupt traditional banking systems, and foster innovation. We invite you to join us on this exciting
journey as we work towards a future where financial freedom is not just a dream but a reality for all.
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1.3 Scope of the work:

In the realm of traditional financial systems, several gaps exist that can be overcome by leveraging the advantages
of cryptocurrencies. Let's explore three of these gaps and how cryptocurrencies pliovide solutions,

One significant gap in the normal financial system is the exclusion of a large portion of the global population from|
accessing basic financial services. Crypto-currencies can bridge this gap by enabling individuals without access to
traditional banking services to participate in the global economy. With cryptocurrencies, all that is required is an
internet connection, empowering individuals in underserved regions to create digital wallets and engage in secure
transactions. This inclusivity fosters economic growth, reduces poverty, and provides opportunities for financial
empowerment. Another gap in the traditional financial system lies in the complexity and inefficiency of cross-
border transactions. Conventional methods often involve multiple intermediaries, lengthy settlement times, and
high fees. Cryptocurrencies, on the other hand, offer a seamless solution by providing borderless transactions with
reduced fees and faster settlement times. By eliminating the need for intermediaries and leveraging blockchain
technology, cryptocurrencies enable individuals and businesses to conduct cross-border transactions efficiently
and securely. This capability opens doors for global trade, encourages economic collaboration, and enhances
financial connectivity between countries. Lack of trust and transparency within the traditional financial system is al
significant concern. Cryptocurrencies address this gap by leveraging the decentralized nature of blockchain
technology. The immutable and transparent nature of blockchain provides a public ledger of all transactions,
which can be audited and verified by anyone. This fosters trust among participants, as it eliminates the need to
rely solely on intermediaries for financial transactions. Furthermore, smart contracts, programmable agreements
built on blockchain, enable self-executing and tamper-proof transactions, ensuring transparency and reducing the

risk of fraud or manipulation.

By harnessing the potential of cryptocurrencies, we can overcome these gaps in the traditional financial system.
Cryptocurrencies offer financial inclusion, enabling individuals without access to traditional banking services to
participate in the global economy. They streamline cross-border transactions, making them faster, more cost-
effective, and efficient. Additionally, the transparency and trust inherent in cryptocurrencies address concerns
related to accountability and fraud, providing a secure and reliable financial ecosystem. With these solutions,

cryptocurrencies pave the way for a more inclusive, efficient, and equitable financial future.

e

Head
Department of Computer Scicnce
Sammilani Mahavidyalaya, Kolkata-70007¢

ATTESTED

Principal
Samniliani Mahavidyar-. -
E.M. Bypass, Bagh:.

Kolketa-7000 -




2. REVIEW OF RELATED WORK

During our research about our related work, we came across various types of Research papers,

Following is the list of some works mentioning approaches and gaps with respect to our work:

1.Blockchain for decentralization of internet: prospects, trends, and challenges:

The authors have described about two consensus algorithms one is Practical Byzantine Fault tolerance (

PBFT) and the other one is dBFT (Delegated Byzantine Fault tolerance)

Delegated Byzantine Fault Tolerance (dBFT):

Delegated Byzantine Fault Tolerance (dBFT) is a consensus algorithm used in blockchain systems. It involves a
group of delegates who take turns proposing and validating blocks of transactions. Validators vote on proposed
blocks, and if at least two-thirds agree, the block is added to the blockchain. dBFT assumes that most participants
are honest. This delegated approach reduces complexity and enables faster transaction confirmation times. dBFT
ensures fault tolerance and reliable transactions on a decentralized network.

Practical Byzantine Fault tolerance (PBFT):

Practical Byzantine Fault Tolerance (PBFT) is a method used in computer systems to ensure agreement among a
network of computers, even if some are faulty or malicious. It works by having a leader propose a value, which is
then sent to replicas. The replicas respond with their agreement or disagreement. If a majority agrees, the leader
broadcasts the agreed value. Replicas check for consistency and consult with each other if there are conflicts.
PBFT requires at least two-thirds of replicas to be honest. It uses digital signatures for message authenticity and is
widely used in blockchain and distributed systems for reliable consensus.

After reading the articles I have realized that PBFT requires all the nodes to take part in the consensus process,
and only need 2/3™ of all node’s agreement to reach consensus.

However,

It lacks scalability to work in a permissionless Blockchain due to its limited scalability caused by high network
overhead and a low tolerance for exploits.

Consensus in blockchain is the process of reaching an agreement among participants in a decentralized network.
It ensures that all participants have the same version of the blockchain and agree on the validity and order of
transactions. Consensus mechanisms like Proof of Work (PoW) and Proof of Stake (PoS) are used to prevent fraud
and maintain the integrity of the blockchain. Consensus enables trust and transparency in decentralized systems by
ensuring everyone follows the same rules and agrees on the blockchain's state.

2.Graph Convolution Network approach: https://doi.org/10.1016/j.bcra.2022.100111

It includes Blockchains Security with Machine learning by using Graph Convolutional Networks.

Graph Convolutional Networks are a type of machine learning model that can analyze and understand the
relationships and connections between entities in a graph-like structure.

Graph Convolutional Networks (GCNs) can enhance blockchain security by analyzing the relationships between
transactions, blocks, and addresses in a blockchain. GCNs extract features and patterns from historical data to
detect anomalies, fraud, and attacks. They help identify suspicious activities and ensure the integrity of the
blockchain network.

GCNs can face challenges when applied to large-scale graphs. As GCNs typically operate by aggregating
information from neighboring nodes, the computational complexity can increase significantly with the size of the
graph. This can limit their scalability and efficiency for tasks involving massive graphs.

And also, GCNs have problems detecting anomaly-based intrusions.
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3.Tendermint Approach: arXiv:1807.04938v3 [¢s.DC] 22 Nov 2019

“Tendermint” the name of the proposed approach, operates in rounds, where each round consists of a proposal,
pre-vote, pre-commit, and commit phase.

In the proposal phase, a validator proposes a block of transactions.

In the pre-vote phase, validators broadcast their votes on the proposed block.

In the pre-commit phase, validators broadcast a second vote, signaling their commitment to the proposed block. In
the commit phase, a block is considered committed when a two-thirds majority of validators have pre-committed
it.

Tendermint can tolerate up to one-third of the validators behaving in a Byzantine or malicious manner. This
means that as long as at least two-thirds of the validators are honest and follow the protocol correctly, safety and
liveness guarantees are maintained.

Which makes this approach similar to our approach is that the broadcasting of information is done using gossip-
based protocol.

Once a block is committed, it is considered final and cannot be reverted or changed. This ensures the
irreversibility of transactions and enhances the security of the system.
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3. SOFTWARE REQUIREMENT SPECIFICATION DOCUMENT

Functional Requirements

login to their [system name] account.
logout of the [system name] account.
create a profile for using the system.
take the information given by the user.
take the user to his corresponding wallet.

YVVVY

Non-Functional Requirements:

> responsive interface that will size to the respective screen of the user.
» same or similar experience across all platforms.

Domain Description:
»> Hardware Requirements:
e PC WITH 250 GB HARD DISK
e PCWITH 1 GB RAM

» Software Requirements: _

Operating System- Windows 10
Language- HTML, CSS, Python, MySQL
Frame Work - Flask

IDE- Visual studio code and notepad
Browser- Google Chrome

C
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4. METHODOLOGY:

This part will describe the methodology of the project.

ANALYSIS

DESIGN

Yy

IMPLEMENTATION

y

TESTING

l

DOCUMENTATION

Analysis phase
In analysis phase, literature review will be conducted by reviewing some similar research
papers. The data and information were gathered and collected during thisphase. Thus, the
strength and weakness between them are able to compare to each other. After reviewing for

the related works, the project objectives and project scopeof this web-based application
project can be defined clearly.

I have used Blockchain Cryptocurrency datasets from Kaggle and AWS for analysis.

Design phase
The user interface and functionalities for this “DCash” website will be developed during the
design phase. In this phase, an intuitive user interface is developed. In additions, the hardware
and software specification are identified in this phase. The website will be designed by using
Python, CSS and HTML coding as the graphicaluser interface is designed completely well.

Implementation phase
During the implementation phase, the coding part of the actual project is started to build. The
languages used for this website development project is Python. The coding will be
implemented and the correctness of the coding will be done in this phase.

Testing phase
After developing the “DCash” website which is able to perform the operations and function, a testing
phase of this project will be carried out. The “DCash” decentralized web application will be tested by
developer only in this case. After that, the question list will be created and the data collected will be used
to determine where the website is well developed or not.
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Documentation phase
After the testing phase is done, the output produced in the previous phase is documented
during the last phase which is documentation phase. The results of the testing and data
collection for this website development project will be also includedin the documentation.

4.1 Problem statement

Motivation

There are various limitations that the traditional financial system faces that hinder seamless
transactions and financial inclusion. Also, there is lack of Transparency in Centralized Currency.
There is Currency Manipulation and Counterfeiting of currency. Traditional currencies rely

on centralized institutions, leading to vulnerability to fraud and manipulation. Cross-border
transactions are burdened with high fees, lengthy processing times, and dependency on
intermediaries. Moreover, a significant portion of the population lacks access to basic banking
services, excluding them from the global economy. These challenges call for an innovative solution
that provides a secure, efficient, and inclusive financial ecosystem.

Objective

An innovative solution is required to provide a secure, efficient, and inclusive financial ecosystem.
This solution should address the vulnerabilities of centralized institutions, reduce costs and
processing times for cross-border transactions, and ensure access to basic banking services for

all individuals, thereby promoting financial inclusion.

Problem statement

* A consensus mechanism needs to be suggested to reach consensus among network
users regarding the legitimacy of a blockchain.
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1. User Registration and Wallet Creation:
e User provides necessary information for registration.
e Generate a unique user 1D and securely store it.
¢ Create a digital wallet associated with the user ID
e Store the wallet details securely.

2. User Authentication:
e User provides login credentials (username and password).
e Verify the credentials against stored user information.
e [f the credentials are valid, generate and return success.

3. Balance Inquiry:
e User provides their user ID.
e Verify user ID.
e Retrieve the user's wallet details from the database.
e Return the balance associated with the user's wallet.




4. Send Cryptocurrency:
e User provides the recipient's wallet address and the amount to send.
e Verify the user ID.
e Retrieve the user's wallet details from the database.
e  Check if the user has sufficient funds in their wallet.
e Create a transaction record with details (sender, recipient, amount).
e Deduct the amount from the sender's wallet and update the balance in the database.
¢ Add the amount to the recipient's wallet and update the balance in the database.
e Return a confirmation message indicating the success of the transaction.

5. Transaction History:
e  User provides their user ID.
e Verify the user ID.
e Retrieve the user's wallet details from the database.
e Retrieve the transaction history associated with the user's wallet.
e Return the transaction history to the user.

Algorithm for the Internal application

1. Initialize the Blockchain:
e Create an empty chain as a list or array to store blocks.
2. Block Creation and Validation:
e Define the structure of a block with attributes such as index,
timestamp, data, previous block hash, and current block hash.

e Assemble the block by gathering necessary data and assigning valueg
to its attributes.
e Calculate the hash of the block using a cryptographic hash function
(e.g., SHA-256).
3. Add Block to the Chain:
e Append the validated block to the chain.

4. Consensus Mechanism:
e consensus mechanism to achieve agreement among network
participants on the validity of the blockchain

e mechanisms for block validation, mining, and determining the
longest valid chain.
5. Output Resulit:

¢ Give output in Boolean
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Algorithm for the Consensus

The Gossip-Based BFT Algorithm
Step 1: Node Initialization:
=» Each node in the network initializes its own state and maintains a list of neighbors to
communicate with.
Step 2: Information Propagation:
= Nodes exchange information by randomly selecting a subset of neighbors and sharing
messages.
=» Each message includes a timestamp, sender's identity, and relevant information (e.g.,
proposed values, signatures, etc.).
Step 3: Information Validation:
=» Upon receiving a message, each node validates the message for integrity, authenticity,
and adherence to the consensus protocol’s rules.
=» Nodes discard invalid messages and keep valid ones for further processing.
Step 4: Voting and Decision-Making:
=» Each node collects a set of valid messages from different neighbors and aggregates them.
> Nodes may apply a voting scheme to determine the most frequently observed value(s) or
take other decision-making measures.
=> Nodes evaluate the aggregated values based on the consensus protocol's rules to make a
final decision.
Step 5: Byzantine Fault Tolerance:
=» Nodes handle Byzantine faults by applying redundancy and evaluating messages from
multiple sources.
=> Nodes can use techniques like voting majorities, weighted voting, or other consensus
protocols to handle faulty nodes and ensure the correctness of the decision.
Step 6 :Iterative Process:
=>» The algorithm operates in repeated rounds.
= In each round, nodes exchange messages, update their state, and repeat the process until
consensus is reached or termination conditions are met.
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4.3 DESIGN

DATA FLOW DIAGRAMS
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[-- CSS Code Application --]

html {
position: relative;
min-height: 100%:

i
body {
height: 100%:
|
#wrapper {

display: -webkit-box:
display: -ms-flexbox;
display: flex:
i

#wrapper #content-wrapper {
overflow-x: hidden;
width: 100%:;
padding-top: 1rem;
padding-bottom: 80px;

body.fixed-nav #content-wrapper {
margin-top: 56px;
padding-left: 90px;

body.fixed-nav.sidebar-toggled #content-wrapper {
padding-left: 0;

t
f

@media (min-width: 768px) {
body.fixed-nav #content-wrapper {
padding-left: 225px;
body.fixed-nav.sidebar-toggled #content-wrapper {
padding-left: 90px;
b
'

.scroll-to-top |
position: fixed;
right: 15px;
bottom: 15px;
display: none;

width: 50px; '
height: 50px;
text-align: center;

color: #fff:
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background: rgba(52, 58, 64, 0.5);
line-height: 46px;

!
i

.scroll-to-top: focus, .scroll-to-top:hover {
color: white;

:.

.scroll-to-top:hover {
background: #343a40;

1

¥

scroll-to-top 1§
font-weight: 800;

i
i

smaller {
font-size: 0.7rem;

}

.0-hidden {
overflow: hidden limportant;

i

z-0 4
z-index: 0;

f

z-1 4
z-index: 1;

i

.navbar-nav .form-inline .input-group {
width: 100%:;

L

[}

.navbar-nav .nav-item.active .nav-link {
color: #ffT;

X
]

.navbar-nav .nav-item.dropdown .dropdown-toggle::after |
width: Trem;
text-align: center;
float: right;
vertical-align: 0;
border: 0;
font-weight: 900;
content: "\f105";
font-family: 'Font Awesome 5 Free';
[l

ATIESTED

.navbar-nav .nav-item.dropdown.show .dropdown-toggle::after {
content: "\f107";
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.navbar-nav .nav-item.dropdown.no-arrow .dropdown-teggle::after |
display: none;
1
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.navbar-nav .nav-item .nav-link:focus |
outline: none;

i

.navbar-nav .nav-item .nav-link .badge {
position: absolute;
margin-left: 0.75rem;
top: 0.3rem;
font-weight: 400;
font-size: 0.5rem;

'

(@media (min-width: 768px) {
.navbar-nav .form-inline .input-group |
width: auto;
j
j

.sidebar |
width: 90px limportant;
background-color: #212529;
min-height: cale(100vh - 56px);
h

.sidebar .nav-item:last-child {
margin-bottom: lrem;

[
]

.sidebar .nav-item .nav-link |
text-align: center;
padding: 0.75rem Irem;
width: 90px;

i

.sidebar .nav-item .nav-link span |
font-size: 0.65rem;
display: block;

%
|

.sidebar .nav-item .dropdown-menu {
position: absolute limportant;
-webkit-transform: none !important;
transform: none limportant;
left: cale(90px + 0.5rem) limportant;
margin: 0;

L
i

.sidebar .nav-item .dropdown-menu.dropup |
bottom: 0;
top: auto !important;

L
]
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dlsplay: none; &
1
J

sidebar .nav-item .nav-link |
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color: rgha(255, 255, 255, 0.5);

.sidebar .nav-item .nav-link:active, .sidebar .nav-item .nav-link:focus, .sidebar .nav-item .nav-link:hover {
color: rgba(255, 255, 255, 0.75);

3
i

.sidebar.toggled {
width: 0 limportant;
overtflow: hidden;

}

@media (min-width: 768px) {
.sidebar |
width: 225px limportant;

1
i

.sidebar .nav-item .nav-link |
display: block;
width: 100%;
text-align: left:
padding: Irem;
width: 225px;

i

i

.sidebar .nav-item .nav-link span {
font-size: lrem;
display: inline;

[}

'

.sidebar .nav-item .dropdown-menu |
position: static !important;
margin: 0 Irem;
top: 0;

y

.sidebar .nav-item.dropdown .dropdown-toggle::after {
display: block;

L

.sidebar.toggled {
overflow: visible;
width: 90px limportant;

!

[}

.sidebar.toggled .nav-item:last-child {
margin-bottom: Irem;

!
¥

.sidebar.toggled .nav-item .nav-link {
text-align: center; ATTESTED
padding: 0.75rem lrem;
width: 90px; Principal
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display: block;

.sidebar.toggled .nav-item .dropdown-menu |
position: absolute !limportant;
-webkit-transform: none !important;
transform: none !important;

left: cale(90px + 0.5rem) !important;
margin: 0;
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.sidebar.toggled .nav-item .dropdown-menu.dropup |
bottom: 0;
top: auto limportant;

L
i

sidebar.toggled .nav-item.dropdown .dropdown-toggle::after {
display: none;
L
:.
.sidebar.fixed-top {
top: 56px;
height: cale(100vh - 56px);
overflow-y: auto;

V

.card-body-icon |{
position: absolute;
z-index: 0;
top: -1.25rem;
right: -lrem;
opacity: 0.4;
font-size: Srem;
-webkit-transform: rotate( 15deg):
transform: rotate(15deg);

}

(@media (min-width: 576px) {
.card-columns |
-webkit-column-count: 1;
column-count: 1;
}
§

(@media (min-width: 768px) {
.card-columns |
-webkit-column-count; 2;
column-count: 2;
y
b
(@media (min-width: 1200px) {
.card-columns {
-webkit-column-count: 2;
column-count: 2;

'

root {
--input-padding-x: 0.75rem;
--input-padding-y: 0.75rem;

i
i

.card-login {
max-width: 25rem;

}
.card-register | @7 S
max-width; 40rem; N
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| whan ovenflows Hhe andificial 8n nodunal boundanfes of
t o stneom , piven on othen body oﬁ wokan oo nonmaﬂj dny
t land. Flood of}en hoppens dufo haavy nafnfall ‘on
+howu‘ina gnow, havoe niven dischange. and becomes oo

i disaster when 4 & hfluances heavy loss of L1:fe and

damaae_”fn infrastructue and propendy .

ACCO“d?”W ‘o Oxford D?c:Honaray —

i “An overflow of o lamqf; amount of wolm beyond iks nopmal

Lmiks, esPec'iCLuy oV Luhal-' e l’lOl’!mcLUj dry land.”
/fh*nemiI ol Kinds of nodunal hazands, +he flood hozard

f most devastoding., wide SFraead and —ﬁaec;uﬂnk
in_monsoon- dominated —lnopi@;ﬂ and sub-ﬂ—noP‘igaL neqions }

Y 001%).
) Tn monseon domineled Asfa. flood e pen petual natural

hazard, whare oven gov. of annuol ratnfall ¢ pecefred
duwungy Juno -to %S'Qpl-e_mben .~ The_ problem of niven flood it OF&
neclx concern n 'H}D_ Indian stalz OF Wesk Bengal , which %
Ilfha owen most nepainer staly fn the Qanam basin .
Maldo dichoict of Weok %enaal % stuakzd i alluvfal
filled ap betwan Ragmahal hille on the. eant. The majon nivenc
El{Jr}UL d;slmgck;omn_ thn o Mahanando., FU_]-:!:M,. Kalind?,
angon and runopyno. Henee, 4hin district Faces the it
thnust of flood wodzn com‘r’n?( from Bthar and Nonth E;;Ti
Ouk of 15 Admimetnodive. Bloeks of Malda, le?shahandnagun;ﬂ
Roctue. T, Manikcholf, Kaliachok T and Kabiachok m hove loeen :
severely offected by flood (Sahana el-al, 2015 ; Abhiskek

Ghhosh & shyamal Kumon Kay . 9012 : Di
Govk. of Went Bengal %”‘9,.20 8 5 Disanten Manage mont=pept-

“_“_—-d
PM—! ead ( 9.) AEESTED
men‘ Ui Gcldgbi‘-r uIJI
sammilani Mahavidyaiya ‘ ke
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21 MATERIALS AND METHODS ;

e enfine Pnoéec\— han bean canried out Jrhnouah E
5cc0ndmhj dedel sonces . e vandows  statichical and
Cantgpaphic Techniques, @uanfitodive and Quolitedivel
deda “analysis method wied 4o show 4ha pulpul of
nesulks. ¢

¢ Malenials io"le r"mporﬁan\— madenials +hose ano wed
“on 4his Pmu:led— Ane — difﬁenenk Open and ovénnnmniﬂ*
sownees Disteict Disanter Managemank Plans, jaﬁom
[15\,"‘?\41 S CC\LGLC{ C\}Tl » qualitadive. cxad quontitotive dota,
col Bencd lood neponts , TMD, published books -

and Oﬁ'HQLO_S‘, many websites , Renoanch wonks and.
O-thenr dnmumcd- nelated belonqings.

’ MEJ‘}fi‘i‘ To complote Hhe obdechives of the pnaJect
*éha%%whom work han been divided into bnoad threo
» Reviews of Llenchue |

» Coleckion of Data

» Andysis and Trdepnetedion of Resuls .

Some QanJrocaraaPh?c_ +echniquas +hose. ane woed o

a

conduct +this proJect ane —

0 Ban OmQPh_
Fw H{\"a
F?gﬁlaw DR o S e e e

Kolkata - 'i(.i \z«D-'“
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thinefone , ho PoPuﬁa#on canoerh and ovenall howsehold]
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IEJ LOCATION OF THE '_STUDy AREAS

S’Pnead?n oven an aneo. of 3733 Squane. ki’[omﬂ}e
with o oepulodion Yof 3,447, 185 lokhs in 2011, tha disteic
Malda' covens 4.24 of total lond masses of 4he stz
of Wesk BQnaai locoted betwan lodHudes From.
04° 40" 90"N o 95° 32’ 8" N and lengttudes #rom 814550
E 4o £g°98'10"E. TThe distwiel ts ' bounded i Hhe |
Goucth bj distnid— Munshidabad acnoss the niven
Glangas by 6anfﬁlcxde\sh ond Dakshin Dinaipun
distdiet 1 eant-'and nonth- cant and by +he stake §
of Bthar and Jhankhand i +he Westand South-west}
The distele e located i sub—tnopicol monsoon dominalelf
neqion. e annwal nafnfall P&Henn n&duaﬁj decneaned
fnom nonth +o souwth due o +the vaniadion i fopegraphl

. ., PoAm P
vegetation characten and onlentation of monsoon ﬂadr, |
The Gongelic flak land of the disteic & composed o}
highly pnoductive. necant alluvium which hon faeilitated]
oqnicwtunal pnodud{vﬂy Lead?na o commaencig) QxPansfo

densﬂj ML very h?ﬁ,h |
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I DRAINAGE SYSTEM OF MALDA |

Riven in the disteict constitule an ?mporﬁunl‘
feoduna upon e landscope. The eanth Sunface hene 7
wanhed by ~he waoves of nfvens ke dhe Gan

a,
Mohanando. , Fulhan, Kalindt, Tangoon, Rtnanbhoauva,

Pogla. and Bhaginadht . Al main . nivens of he district
are. of the H%malajan on Sub—l-h'moji}yan oni’a‘in and flaws
towands south direction. Due 4o 4he devan%dfn@ Aood

Pqn-lﬁ"c.uflomlj mn the western ¢de of dho dselnict b
amount of LK

e and propenty, hunan ecfublshnanl
ond &an?cﬂm land aoag into +ho Gla:S iu Qfsvemrfnl:
each Yean, {

» GANGA :

Riven G\&na& Nows —Hmouah dhe westenn
PanP oF the diskniel and det an a nochmol division

between Jhankhand end Malda disteict="The Gangal
Fingl- Jouches Hhe digtnick an $+ sweeps nound—)j

the south of the Raymahal hills and leaveo dhe
distrid= ot Khegunia. near Farakka Banncge .

Rogmahol ot s west end almost Hhneatened
4o cuk into Hhe niven Kolindi, an o nesult of which a

qood  amount- of  enosion ook place. 0 the Malda
bank. Bub-od the present timo the river has bean

Q
flo wma/ & nouah +he_ ("_h ann e}/
PJM) Head =
I sl
iatin Stn.I%
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>> MAHANANTDA : —The main channal o? n?vej
f‘jlo“h‘l”“”d‘l i Moldo disteick 13 *Eu"nlj desp and

I olluvium  and d7luwv fum protesses Gne oing on
ﬂ”&d&‘luj» Riven Mahanando. nuns for “aboul 6.6
Km in the disteict ond  divided he distaiet fato Hwo
nearly equol porions sn pedins —iithe eastenn negion,
cons?dintav mainly of old olluvial and nelatively in rilg
Soil 18 commonly  Known an Banind , and +ha (1). Wetern
pegion, whith fe funthun subdivided by +the niven Kolindi

nto ~+wo anoan , nontharn onea. 15 Known an ' Tal’and
Soudtenn anea is Known an ' ana’.

“The. Moahonando. niven system consiels of wo

| streams —ona s locally Known an Fulahar niven and

+ha O‘H:L!m Mahananda. , Mahanando. on‘:ainaﬁfn $rom the
mowidasino ws naafon of Himalayas,

» KALIN'DRI® Kalindsi niven & a-tdel eshuanine

1 o ond onound +he Sundarbans i Nonth 24
I gla‘fnanafa distnickn the Indian stalz of Weot BQnﬁaLL
boraadenfncav on Satkhina. Disteiet— of Ban?[[adexah.

T entens frto +he Malda dighnpick nean Miaaha
Gf M’shc‘”\and”&[ﬂ”“ﬂ ,in the Tal ne ton ,~+he piven
Kolindn? neceived ~four —ibutaniec, namely Kalkos.,
Kankans Kos and Baromania. Thene —f%m small
"l’ﬂ?bLt’l’CLhiﬂ_S OP K(ll'l,nd!ﬁ dnain +the € xess wc&ﬁl Oﬁ'Tcﬁ_
ne.a‘iun ond maet niven Kelindni. Aften than, Kol dn;

n
o (o]
18 —ﬁowma

mainly n outh-eastern dineclion and maots
niven Mol
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& COMATIC CONDITION. OF VALDA | |

The climodie chanactenistice of 4he distnick can
be considened an ono of 4he explanotony factons fon
the notwie. and 4he type of sunfoce Weden bodies
essentiolly the bile’ T ~the disteiels Reduckion in he
walzn quaﬁ%’es duninge summaer months and raecharﬂfnd_
of wokm duing monscon and post= monsoon mon-hs
depened o o gneal- extent- on dhe tempenatune,
humidiy and precipitodion. Ratinfall notunadly cansie
Sl{ah’rl Mone_ Lua_‘:’ah‘ua& n de“renm?n?nta’ +he nec.hana
quan%oj of wolm n the bils . The disheict with Hs
notoriown —flood,oncﬂ baakca»nound Pmov‘fdes ~ha_

nechargingd aquant™y and gualtly factons of Hhe bils
of ma Alia di:‘%i’dﬂ‘ PR TR

A bnlel— descni’p%n of 4ha  climadic Panama’rens
Of +ho diS‘iT'?c\" e ar%en below

The Maldo. distnicd— (s 7 n‘iﬁ’canHj unden hot-
and humid monsoonal climale.'An Oppressive Summe
seanon , pondiful pafn and humid actmosphene all
fhrough 4he yean ane. 4he main chanackenistice of
the climadic condition of Malda digheict on 4he
baols of tempenatuna vardation painfall, hum?d?b
ond winds |, the yoon oﬁ he disteicd— can be divided
o foun  well deﬁn&d Seanons., /

oy (1)
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. 0 — 1) Hob—Summaer $eonon — Maonch o Mog
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e Soun well definad  seanons of Mold o_distriely
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2) Monsoon Seantn — June o SQthbe_n

3) Qﬁne&%na Monsoon— Octoben o Noyember
4) anhzn 3eanon— Decamben o Febrauoﬁ_j,

= ot s Sy o sy

1. Summer Seanon :

The. hol summan Seanon Stands faom Manchdand
ends in +the 1S weel of June . TRis seanon mounlj
chanactenised by a nise in +tempenatune, fnenea
° Jhe ammount and PFnecLuﬂnP nadnfall f dunanal
rmnfd& e? 4empamrhum. “The ~total &ven&&+ernpem
adwe. of this seanon ¢ anound 30°c, avenagediupd
nfma"- of aboul- ¢ ond vaaaa nai’nqeoii_ 1s 308.7 mm.

9. Monsoon Seanon

“The. monsoon Seanon of- Malda. dishefel mdinlj
Stands fnom TJune and extends upto Septemben month
The seanonal chanoctenfehice  meludes weal surface
winds, cloudy sKy, hiah hum‘fd?b and Sanj weothep
The average nanfalll duning +he mongoon 52000N

% neconded 250 em., Moaximum ammounk of%ha_
nainfal of he yean in the distnicdl—-tokes place

dumonﬁ thes pem"od. _—
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The | st strods
inten geanon In Malda ijﬁ.:d s
-WTb@ Wit %b” aﬁon s cool
F’F?m Er)ee % lise phenomana of thir ge
chonocetent

onthly
orning fon avenage m tnfall.
w%&hwo(h) f 0 e-iué; \: TO”(L a;a\/cl o \HHe amount Of ’pwnfaﬂ
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RaINFALL AnD HumMIDITY
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“The Owenaaa_ &nnuaﬂ_ nafmgﬂl 1S 1326.08 mm %Om
 yean 9014-2018% T mnimum nainfoll fn 4he anca an
pen TMD g_’[‘ndfan Me’reomﬂoa?mL DePanl—mo_na data
wan neconded §n Ahe mondh 6f TJune and TJuly

Follwed by Awqust- and Septemben . The nadnfall v

" winter seanon’ 18 veny loww I amount:

"TEMPERATURE |

This disheick lles tn neon f—Hmalajan Foothslls.
So 4he. climakg & nob —foo much hot; The minimum
fempen echune of the disteick Lse $ the mondh of
Jonuony and Auquat ﬂesPed{ve!y and -he moximum
+e.mpenor\um_ lten ” wih fn 24.9°%¢ and 36.1°¢ i Hho
mo nh 0? Januanj and APrﬁL nesPeaﬁve}y. |
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= TEMPORAL CHANGE OF WATER Level| |

AT D il ety § AT A it B

As pen Grovennment cf India’s wcnjln Eesawmits.
Tndonmedicn System (WRIS) and Corvtnal Waksn Commissir
(cwe) monscon penfod compnises of five mendhs, from|
Junt o Octoben. Consequently , flood seanon olso
Comprises  Faom June +o Octoben , The distribution of
monhly cverage rdintall 1 he stade Fon s seanon
shews ovenall “normoll aednfall with average Jofeik
C;f naJcniEaJl Gﬁ 13.27. Hhal vonies -fznom moxim um.
de—‘r%C_TP o{ 49.19 in June, 2019 4o moximum SWLleJ
ef 19.24 in Octoben, 2019.

Tn June, Malda hao normal discheage and Hhe
noinfall walm & caPabLn_—Fon nivens of Maldd distniet:
Tn Septemben , Riven Fulhar ot Telsana where qauge.
hed cnossed EDL duning heavy precipitodion eind iven
C’\Oﬁﬂ& al- Man?kchakahal—, Malda. whana aauaa hod

Cneesed EDL dwﬁna hwgy Pﬂec?P?‘l'CL—HOﬂ ay well an
Upper Codchment dischange . Lant week of Tuly,

middle. Gongoe baaln ¢talled affechd by aowde Level
in Malda. Riven Fulhan in particdlar, condineount flowed
o olanmne  evel dusu'n i P

. ‘a’ enthne month due o Jhe_
prolenged  hain ond i accumuloded of sl uppen
cotchment sttuoled  gulside of 4he shlz.
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In Aucdwa\-, Raifall of 2019 wan deficient: :
HQRCL, Niven g—‘—gﬂgg wene. Q_Lgo nok "ITBOUJDLQ somae_. In

| September, Riven ¥ Alhan ot Telsona. whow auge hod
cnossed DL duning h.rmvj pnedcip]'%rrHuﬂ anc;ﬁ Rven Bangod
L ol l\/lokn?kc_h&wahah Maoldo.  whone am@e had cnosse

i?'s—diﬂ&i%iza’ hwvy Precapitetion an wellan upper eodchmant
From the peniod of 2001 o 2010 ~+he highaat-shift
| under only Hhe part of +he Uttan Bhakunla. From 2010 +o
p 2018 +ho hfal'uml- shift duwe o enosion and flood nuan
So‘mballe - BM?"PM, Namﬁnpka (hopcdpr and Bishnu*Z
i pur— L&kshﬁ')u}y_, s
_ Dunfna ~+tha Penfod of 1973 4o 2018 (45 75‘1‘“5) é
| the moximum Ymj ':acrf—r'on of 4he niven bank which baH\§
left- and the night bank han  ghifled nesPec{fv@_y.mg
ovenall shift off 4he niver cowrge Hme span 4nom1913¢
to 2018, shows —+hal- the highest- pondion of 4he shifi-
wan ot Rodua-I block , aboul 4,8 km both of the bonk
of +he niven. |
Dug 4o chifF-of Fulhan niven UHan Bhakunie,
Dekshin  Bhakunio,, Manik nagon, sthnupwt— Lakshipua |
and Duwitiya., Bhaaalptm ane Mosk hazard oun parte
N +he 6"|‘LLdy (T Xs & _ﬂ&naﬁm&, becoune of every yean!
:rlood?n@ and enosion , -the lef- and rﬁﬁhl- bani of Jhod
F‘LLU'UIJL DTV("_Q han Sl’liﬂ'ed VaJ)'Hj/

oy (1 Y
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= AvutsioNn OF RivEr FULHAR 4

“he Fuhar niven f¢ an ?mPorﬁnn{- piven of ;lhﬁ
Malda. disteitt, extends aboud- &0 km. Tt % a main
flow of 4he niven Mahananda. e n{ven flows ~H1nou(jh
Bihar and enter 'n the dighaiel nean Minaghak of
ku%hchanclmpm-ﬂ block. and manges wih Gange-
ok Manikchak. We have gtudied +he SP&HO ‘f'empono.l_
Shifk of 4he niver channel (1972~ 2018) of Fulhan
niver in 4he Malde digtnie wanﬁ «ﬂeos})oc]ﬁal mﬂ_thod.:

Forn dhe ’hzm’)onal Shifl— of +ho pulhfn rafvo_r:’s
19.eross  geckons hove bean mede @vemntdv entine_

“ho S’hldj aneo. which has bean Qaﬂ_c_uh—k& [e-ﬁ and. |

night— bank of dhe_ riven n metens. TTRa thpeo blocks
o.nl mo.fnlj 0fPected acnocs 4he enoss secHon nean

Hm&)hch&ndmpm—ﬂ block , Rottuo- T block. and
Manikehak block .

From 1973 40 2018 , +the moximum slﬁfP wan ak
Rodtua-1 ond Hwﬁ’.ohchclndna’om~ﬂ blocks which have

oboul- 2998.¢ m and 1066.4 m on 4he night side of
+he. piven bank. and 2014. 87 m and 1085.2 m an the
left sida of dha_ niven bank . In 4hi» bank m| nodion,

comes unden Hhe vHan Bhakunia, Pachim BQQKME(L,

Maonik nagor and Duj’-}?ja , Bdapwx v‘fllaae_ which han
the most" affected villages .
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P L R R T e S L

. P R TS T
Heaq Principal
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the Hmae emod_ 1980- 1990, the shi f’r ls€
LUICIQ SFnE&d

o Koduo.- I block , 12.82.43 m nm*'thE
teft and 153116 m neon 4he night— bank of Jhe niver,
From 1990 4o 2001 o moximum number of enoded
comes under UHay Bhakwuo., Kamalpwm ond Mani k-

ﬂ an v;lLGLleo and han lan a pant- an 1560.89 m

Omd 1392. 68 m od tha nfant and left pant of tho |
niver bank nesFedwe,\lj.

@

ATFESTED
Head i
Departmeny of c.sqg aphy rincipal
Sammijanj Maha, ala 4 Sammllani Mahavidyalava
Baghajatin s, I a

E.M. Bypass, Bagha':'-""'-
Koikaty - e 4”3355

Kolkala-T000u4



- e R 1

1’ ;- L = |

i T MAD ne { O a7t v 1

VULNERABILITY MAP of IMALOA Distfl

|

\ -rh- _:‘; h‘_ﬂ ™o .'*."““; \.

| MALDA DisTRICT | §

PRI : HIEST ReNRAl '?

DINATPUR ¢ FES BENGAL ‘

4 "
L
3
]
H
i

INDEX

FLOOD SHELTER
[1] HEALTH CEnTRE
(&) PoLice sTATION

[l FLooD-PRONE AREA
sl Rivers
EROSION= PRONE AREA

S0URCE : DISASTER MANAGE MENT
PLAN , 2020-21




T T T TN NV MLV UUYIRCD L EEE TS Y

3

pR—
S A TR o A s e B s BN T e T

Bh [FFECT OF Floons IN MAIDA | |

Floods con somelimes be a- huge desipuclive
Powen hav?nca/ de vwo-l-bth'nrdf e{fects . Besides -1he ph«;si’cal
danﬂen that' {loode pose , they caune. economic and
sociall PnobULms t00,

Tn '”'li MO.l(la df&'lp(i’(l— 'ﬂoodg CU]CI nfven_banl,ﬁ
enosion predominandly affeck -he distnict—a 9 1 [ocoled
in “the monibund par! of Jhe Benaal deto.. Tho main
effecls of —ﬁoodinc(‘f.. h Malda ane—

A. PHVSICAL EFFECTS:

» Impack on Environmant-: Flosdibe: & Malda biss 5

huge nange. of mpacls on-the envinoimenk, i cluding-
o ildl e-‘d habitbs can be desﬁoyed by flood w a
e "Tnees can be upnooted by h:'ah velocily of wolen figus

e Plants +hal suvive. 4ha jnitial’ flood dr
be‘r’nrﬁ inundakad wih uﬁm. TG s

Y Londslide Ry :  Dexdo hiah velocity of flood walm

4‘11& “neas #rom Hho niven bank' 0P 4he "side auan of
the niven can be upnooted , which may cowe a huge

landslide. ik v 4hal partcalar anea.

)> River Bank Erosion : Besides, landslide nisk,

Jhane ane_ high chanca. of niver bank enosion by the_
igh velocty "of wolmn flous. Maldo. disteictt ‘wel

Known “for riven bank enosion by floods i eveny vea.,

S

e i L e L i, .
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B. FFFecTs ON HUMAN LIF[ ° a

> Loss of Human Life : Floods one considened o be

ono 0E+Fu£ sevene. weolher Killens. floods C(”‘-")P"’E“’
awoy ™ %mlrfmovf’ncda waokay op ¢ dpowne -Them mumnd
deo-th.

> Damcxﬂ& of Froperty : Floods fn 4he Maldo disleid

coune aneak loss of priopent and belontd?n 5. M also

counes damarda ~o buﬂdinfﬂs by blowin oul w?n(IOUfS,
sweaping awoy doors, conrod ing walls' and --founcclja-lwns
and ccj;ny?n debnis nto dha | froslpuctune an 28
makes Hs woy i, at a Fant paca.

> Dieruption of Communicadion : pue 4o flood in the
Maldo. disteic a» well oo in Tndie dispuption of 1ha
communicaion system fs a common fncident cawed
loy 4he Flood.

> Loss of Live.stoek : Deoth con be the gnavest effect

of flooding-. Besiden human life., many domentic and
wild animals ape dnownad by 4he flood walz i
every yeon oF ?Loodf’na’ in the Malda distaict

¥ Woten Pollution and Diseases : Dunina flood many

porsonows gubetances mixed with +he niven walm ar
i+ couned walm pollidion. By thwne contaminated
walzn  cawned  poder borne. , Black-foot ete. deadlj
diseanee which have deadly effects on liven.

> Elednicity Supply ofF - Aften adevamhﬂnﬂ -ﬁood

condition sometimen +the eloctnicity supply can' be off
for electric posts and wires domage i Hhe anca.
.
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FEFECTS OF FLOOD IN MALDA |

e = = R ——

PIC-1: EFFECT ON' SETTLEMENT  Pic-9: DAMAGE OF cRops.
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PIc-3: RIVERBANK SOIL EROSION  Pje—: WATERLOGGING SITUATIO
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ane one of the most common hazands in Wesk Btamal’
' aldo

e R

[ Floop MANAGEMENT PLANNN@J—_E

|
Floods can be serioun Catantrophes and they

esPecFaﬂ) of Malda. i Norih -Beﬂﬂ&l- Tnh cone o?
Jhe flood disanten s hiﬁhl); cornelated with heovy
and sudden naimeuﬂ. ond ~dam “fotlune manaaemfmk‘.

D?sc?PUnanj oand fhoduchve aPPnoach ‘;’nctudf’ncﬂ»
pre - flood plan oand Post flood managemant- PUiLﬂ-
TRenefore_ ik is Keep imPon-hmlr o guF o Plan n Plac_a_
dealing with flood n an Onaan?zed way uJ?Jrhaﬂtho_
Stakeholdens, who ane well ‘awona Of +hain dub n
nesFondinrat on pne- PL&””?"‘{]" pen disanten.

g

NDMA (Notional Disasten Managemant Autharily)f
ond DDMA (Diern?d— Disasten Mana e_n@anl— Au%hon?’rﬁ

are- worKin Fl_oapdhﬂﬁ on an C"mm—{ aimed ak improvi
the way peopl& PDEP&M—‘FOD on nespond an Severe. Auathdy

Te DDMA (Disteict- Disacter Managemant- Authoriy)
nocoss §5 Jhare by bring  legtimocy o the. entine_
prowss: TN endine. pnociss wan divided o Fhnea ;i'

phanes e Pre- digapten ackv‘ibv : Dw\fna Disanten |
activity and  Posk disanten ad{v‘i’br which wene
mofnlj Focwed  on e ponometens,

v ———rrrr—

TED
) (20) %MJ
Head fincipaj
Sam . pa
Department of Genranhy ani Mahay;
Sammilani Maha * “:ya EM. Bypass fdy{alaya

» Baghaiasi
Baghajatin Stn./t. .. “ipass ) KO.'kata-?OOQ i
Kolkata - 700 094




v W W oW g UG“Q"C"UWVVU‘WJ'WU' 7

W v w e -

— ]

T et % e '2 3.3 Ryt e

e e

P S At e v ik rt

A Be_ lood Annanaemen\-s:
meetions of Distrid Block, Gnam Fanchayat and

ﬂem enl- Committees

i. HOldlnnﬂ
~ Giram" Sansad level Disastern Mana

and uPda—Hna of COnl{mﬁencj plan.
9 functioning of contnol room fn collectorate as well an fn the
ofﬁ‘c,o_ o% i(,@y GiP blocks, line depankmenjrs (Spec‘raﬂj
police, inrigadion, Agnicultune, Animal. Resouwrce , PHE.
PWb, Mahcjanda Embankment Division and Healdh Dept.

. J _Tden—kﬁ'ca%n OE vulnenabli aneas , VLd.rLQnabLL noups

i 4. Communicotion oE piver gaugl peodin eﬂa vanjoun nivens
aa @Jda and Central

ond_ people and mapping Jhornof Repain and fnainkenance
of flo%dehel[-ens. PP ﬁ P ainten

lssued by flood Hone calshin cell m
Wah?/z CommisgsTon . Palcna o raesPechg SD0s, BD0s and

GrPs.
5. Dissemfodion of ﬂw"nfuﬂ, weothen end Flood nePonJcs,

pecived fnom taovennminl— and IMD.
&. Tnstallation of temponany Polie KT sets o different
vulnzrable points in addHion 4o efcah¥ inm’aa'\ion"l?se{s.

Y /fnnar}ﬁleﬁmn""s fon 3—|Unouae_ of adequaﬁ nelieﬁ
maoJdeni .7“0?11 eveny block :rw:liefi ao-down Stoek O‘Z
Sub- Division 0ffian , chanchal is Yolso 4o the enniched.

8. Roling stock oft kerosene. 01l b be maintained

l\éra D e Big dealer and Aaenl— levelajn Qoll;r@ gtck
of nice ot Jhe” nice_ millens level and

g it (e down,' mMillens level and odequald stk

wy (2 GBSO
o - Do
Department ufGepgraphy Sang;z";ﬂpaf
Sammilani Mahavidyalaya - Bypas ahayid}'afaya
Baghajatin Stn.JE ©.. Bypass Ko;kafaf}(i;ghafa;,-n

Kolkata - Tuu 094
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A Activihes Dwﬁ’na Flood :

1. Comdrol noom will funchion nound 4he elock, OT seb,
Telephone. ond Fox will be. done i wonksi condtion. |

(
9. People. will be. made aloak with study ofanavi‘b
of stuodion and evacuotion will be 4oken ulﬂ-o +ha_
people. of hr'rah nisk =zonu . | |

3, gooir?ij and othor conveyance will be deployed i 6Pnalreﬂ?t

1: Shelten Manugemant with deinkihg walm ﬁkd)lb/ and.
santtaction O\n&nanaemenk— will b@ ensuned

. l\le_u;ssah_j séeps o be?naﬁhka up -’I%n ankfna ond
pe- Sinking oF —fube- sells U and se{»-h‘na up of Ulodnind
15 beln jnsu.im_d —H'lnouah “otal  santtddion Pnﬁ‘ﬁnﬂmmﬁ
in the “identified flogd! shelten,

6. Health SysFm deva\'oPmin\“ schame_ have bean ~aken
up fon  betten hoalth Senvite_ o Jho vidnenable People,
NGOs 1o be. mobilised —to 4hin wonk also.

4. Co-ondinoion meodin with d'rﬁ?mnP line. depanhmz
~fon —lukfnﬂf Sollow up l&sq}m, Relief and Rehob; litafion
Prognamme’ and o anons‘,’g ~he. prnoblem and acton

*}akmﬁ deciaon .

T — >
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MANAGEMENT AND PLANNING of £L000

SITUATION o MALDA
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PIC-1: CONSTRUCTION™ Pie=2: CONSTRUCTIONT
OF LEVEES O~ RIVER DAM

VSING SAND BAGS

P(C—-B; ST* FLOOD RESCUE P[C-/—]: PROV‘DINGI REUEF
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= CONCLUSION |

De.—r'%ﬂes}‘cch'on Via- a-Vvis envinonmental de( nadaction
n ~+he ujabJ‘Lsheds Oﬁ dhe Sub—Himahlym niver indecd :
Plays the deefeive. role i Ccn-}empor?&ﬂj incpeaned
-ﬁaequmHj and moagnetude_ of hozards. Viciows Cycle of
de_ancxdcx—!ion hon aineadj been estublished n 4he Sub-
\—Hmahlycm walm sheds. PEnhaPs,—}hL cnlj Poss‘.’b‘:l‘?kjr}o
Sove_ Jhe habtbale  envinonment lies o —l'hL]DnO—OCHVP_
waliﬂShﬂ.CL m&nogoeﬂw_ﬂl" I is thwe, oun u'mPo_no:Hva dub
o infonm e people_ Living in dhreahdld anban with 5k

woltisheds ( PrghtbHive ich i
v hgmd neam_/r;eé% chive Zone ) Cakegonically

; S ?b S ; 1
Al eru.aem i ﬂaﬁshﬁ sible. hand hip duning he

manaaernmt- pnocess!

] leb w tell oun PeoPl& lving in “hneshold ancas
(ProhibHive /nestnictive_=one) anrerdony thot yow ane_
Livin cj’n on unsaqfei_mog and SHis noljfposg?bLL—}o
provide yow Secuily ogainst— possible flood. TR land.
une PQ'H‘@-H; howbg'lype(a_ fTIwa% Pb€_ suii’abLL% Cof)gci
Ahe possible. 4hneak: T tmoditional one and Ufe Shylt
O‘F lltvinar with —ﬂood muwot- be. adhered —5. ]

/

200 vl £ M. Bypass, Baghaiatin
: Kalkata-704084
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TABLE : MoNTHLY AVERAGE TEMPECATURE. DisTRiaumon

i AL

N 2027
: | | i

i _MINIMUM | | | |
z -IEM:E%ME 12.1]14:819. | 22.9|24.¢ 264515'4[ 95.8126.1122.4/17.6 3.8

MAXIMUM |

‘mwzéga‘ﬁmﬂe 2311261319 | 315 33.6}22.5| 3114/ 31.4 | 31 [29.9/2924.5
i| AVERAGE
] TETBCSRATURE_ 175 20.8|25.5| 98.5|28.9128.919¢.2.19£.2|23.¢.| 2¢ 925 19

TABLE : RAINFALL. AND Humipity DATA 0F MALDA
2021

JNC
MONTH RAINFALL(mm)|  HumiDITy (1)

JANUVARY 16 68

FEBRUARY 20 6l

MARCH 26 19

APRIL 63 54

MAY 182 0

JUNE 159 gl

JuLy 313 €9

AVQUST 204 84

SEPTEMBER. 283 €5

0CTOBER. 19 g0

NOVEMBER 10 69

DECEMBER G 68/ L
W
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Assignment 1: (MS ACCESS)

1) Create a database file and name it as StudentDetails.accdb

a) Create a table STUDENTS as per following schema:

Field Name Data Type Size Constraints
Registration No Number Long Integer Primary Key
St Name Text 50

St DOB Date/Time

St City Text 30

Contact Number Number 10

b) Enter 10 Records in the table STUDENT:
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1) Create a database file and name it as StudentDetails.accdb

a) Create a table STUDENTS as per following schema:

i. Open Ms Access and Select Blank Desktop Database:
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ii. Create a Database and name it as StudentDetails.acedb:
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iii. Tap on Table and select Save:
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iv. Change the Table name as STUDENT:
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v. Set the View as Design View:
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vii. Set Field Name as St_Name:
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ix. Set Field Name as St_City:
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xi. Save the Table Design:
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ii. Fill the table STUDENT as per student information:
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Assignment 2: (MS ACCESS)

Create a database named "Company" with two tables "Employees" and "Department".
Follow the instructions below:

1) Table "Department" contains fields "Dept_ID", "Dept_Name", "Dept_HeadOffice",
"Annual_Turnover".

Note:
e Dept_ID is a primary key

2) Table "Employees" has fields "Emp_ID", "Emp_Name", "Emp_DOB", "Gender","Salary"
and "Dept_ID".

Note:

e The "Gender" field can take values among "Female", "Male", and "Others"
e Emp_ID is Primary key
e Dept_ID is foreign key referencing Dept_ID of table Department.

3) Insert at least 5 records in both the tables such that the queries given below generate
some rows as results.

4) Create queries for the following requirements:
a) Display all employee names, employee id and salary.

b) Display name(s) of employees of employees who earns more than Rs. 5000 per
month salary.

¢) Display all Department Names along with the Head office City and Turnover.

d) Display Employee ID, Employee Name, Department ID, and Department Name
of all employees.

e) Print name(s) of all Female Employees and their Date of birth.
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1) Table "Department" contains fields "Dept_ID", "Dept_Name", "Dept_HeadOffice",
"Annual_Turnover".

a) Open Ms Access: Start > Ms Access > Select Blank Desktop Database

b) Create a Database and name it as Company:

Blank desktop database

¢) Select Design View and set the Table as Department:
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d) Set Dept_ID as Primary Key:
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9) Table "Employees" has fields " EmpID "Emp_Name", "Emp_DOB",
"Gender","Salary" and "Dept_ID".

a) Create Tab > Table > Design View > Set the Table name as Employee:
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b) Fill the Fields as Emp_ID, Emp_Name, Emp_DOB, Salary, Gender, and Dept_ID:
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o) Select Lookup Wizard to modify the Gender Data Type preferences:
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e) Mark as Tick in Limit To List box and Finish the Lookup Process:
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g) Select Both > Add > Relationship between Department and Employee:
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h) Drag and Drop the Dept_ID of Department Table to Dept_ID of Employee Table >
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i) Dept_ID of Employee Table is now the Foreign Key of Department Table regarding its
Dept_ID > Save the Relationship > Close:

o
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3) Insert at least 5 records in both the tables such that the queries given below generate
some rows as results.

a) 5 records in the table Department:
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b) Enter 5 records in the table Employee:
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4) Create queries for the following requirements:

A) Display all employee Names, Employee Id and Salary.
i) Create Tab > Query Design > Select Employee from Table > Add:
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ii) Fill the Field names as Emp_Name, Emp_ID, and Salary > Run:
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iii) Query 1: displaying all Employee Names, Employee Id and Salary:

Comparry : Database- Al 1 Dirive' D s\ Company.acods ihscess 2007 - 2013 file format] - Accesy ? - X
HOME  CREATE  EXTERMALDATA  DATABASE TOOLS -i3
s 3 ?’ 2] Asending T Selection = 3 Tetaly

ending Tl Advanced - % spelling

. diews B e P %
. ®
All Access Obje... & : . T s ESe=
- P, ¥ i
3 & i =,
S:r: z  Ricky Alch £ 12000
éﬁ K Purnime Ssha  E347 FO00
e n_fw‘m.*._ e | Arya Dutts E346 10000
Hiemploree 0  Radhika Sanyal £349 EODO
jiv Ganguly 250 e 16000f
o




B) Display name(s) of employees who earns more than Rs. 5000 per month salary.

i) Create Tab > Query Design > Select Employee from Table > Add:
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i) Fill the query field as Emp_Name and Salary > Set the Criteria of Salary as [>5000] >

Remove the Blue Tick from Show > Run:
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iii) Query 2 for displaying only Names of the Employees who earns more than 5000:
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C) Display all Department Names along with the Head Office City and Turnover
1) Create Tab > Query Design > Select Department from Table > Add:
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iii) Fill the Fields as Dept_Name, Dept_HeadOffice, and Annual_Turnover > Run:
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iv) Query 3 for displaying Department Names along with the Head Office City and
Turnover:
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D) Display Employee ID, Employee Name, Department ID, and Department Name of all
employees.

i) Create Tab > Query Design > Department and Employee from Table > Add:
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i) Fill the fields as Emp_ID, Emp_Name, Dept_ID, and Dept_Name > Run:
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i) Fill the fields as Emp_Name, Emp_DOB, and Gender > Remove the Blue Tick from
Show > write the criteria of Gender as ‘Female’ > Run:
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iii) Query 5 to display Name(s) and Date of Birth(s) of all female employees:
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Assignment 3: (MS ACCESS)

1) Create a table 'AccountList' with fields AccountID, AccountName, AccountGroupID.

Note:

e Data type of AccountID is number.
e Data type of AccountName is text. This is a primary key.
e Data type of AccountGrouplID is text.

9) Create a table 'JournalTransaction' with fields VoucherNumber, DebitAccountName,
DebitAmount, CreditAccountName, CreditAmount, Narration.

Note:

¢ Data type of VoucherNumber is text and is a primary key.

e Data type of DebitAccountName is text. This field is foreign key referencing
AccountName of table AccountList.

e Data type of DebitAmount is number.

e Data type of CreditAccountName is text. This field is foreign key referencing
AccountName of table AccountList.
Data type of CreditAmount is number.
Data type of Narration field is text.

3) Create appropriate data entry forms with two buttons 'Add record ' and 'Save record'
in both the forms to insert new record and save.

Note:

o The data entry form for 'JournalTransaction' should allow entry of account names
from existing account names in table 'AccountList' for both the fields
DebitAccountName and CreditAccountName.

4) Insert records in 'AccountList’ table from the given data through data entry form

created.

AccountID AccountName AccountGroup
;1 CASH ASSET
2 BANK ASSET
3 PURCHASE EXPENDITURE
4 CREDITOR LIABILITY
5 MACHINERY ASSET
6 SALARY EXPENDITURE
7 POWER & FUEL EXPENDITURE
8 LOAN TO APU ASSET
9 INVESTMENTS ASSET
10 INTERST RECIVED INCOME
11 SALES INCOME
12 DISCOUNT RECEIVED INCOME
13 CLOSING STOCK ASSET
14 DEPRECIATION EXPENDITURE
15 CAPITAL LIABILITY
16 PROFIT & LOSS A/C LIABILITY

E.M. Bypass. ®
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1) Create a table 'AccountList' with fields AccountID, AccountName, AccountGroupID.

i. Start > Ms Access > Blank desktop database > Create a database as
AccountingDatabaseSystem > Create.

i1, Create a table as ‘AccountList’
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ili. The Table named ‘AccountList’ with the field ‘AccountID’, ‘AccountName’,
‘AccountGrouplD’ respectively.
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2) Create a table 'JournalTransaction' with fields VoucherNumber, DebitAccountName,
DebitAmount, CreditAccountName, CreditAmount, Narration.

1. Create tab > Table > Name the table as 'JournalTransaction'
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ii. The table 'JournalTransaction' with fields ‘VoucherNumber’, ‘DebitAccountName’,
‘DebitAmount’, ‘CreditAccountName’, ‘CreditAmount’, ‘Narration’ respectively.
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iii. Save the table ‘JournalTransaction’
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iv. Relationship between ‘DebitAccountName’ and ‘CreditAccountName’ of table
‘JournalTransaction’ with ‘AccountName’ of table ‘AccountList’ as foreign key referencing.
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iii. Drag and drop the button [xxx] > Record Operations > Save Record > Next > Select

“Text’ > Next > Finish
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iv. Click on Save > Select Form View > Journal Transaction Data Entry Form.
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v. Layout View > Form Layout Tools > Design > Drag and drop the button [xxx] > Record
Operations > Add New Record > Next > Select ‘Text’ > Next > Finish.
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vi. Drag and drop the button [xxx] > Record Operations > Save Record > Next > Select
‘Text’ > Next > Finish.
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vii. Click on Save > Select Form View > Account List Data Entry Form.
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vii. Save and Close all Forms and Tables.
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4) Insert records in 'AccountList' table from the given data through data entry form

created.

i. Fill the Account List Form with given data.
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5) Insert records into table 'JournalTransaction' from data given through data entry form

created.

i. Fill the Journal Transaction Form with given data.
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FIELD REPORT




INTRODUCTION

A field trip or a visit to the zoological garden is actually an inseparable
component of any student or person interested to in the study of nature,
specifically the fauna and it astounding diversity. The exposure to wild life,
whether in its in situ or ex situ status, provides a first hand, audio —visual
information to the observer.

Needless to say, a visit to a biodiversity zone or a national park is the best
way to observe nature and wild life in its exclusive environment where its
behaviour and interaction are not compromised by the restrictions of diverse
types as found in ex situ conservation.

Of all the different dimensions of the biology of animals, perhaps the aspect
of ethology is most intriguing; the interactions of animals, with their conspecifics
as well as other species, with the environment, and of course with visitors when
interacting in close confinements of a zoological garden are most unique.

Interestingly, the aspect of animal behaviours extremely diverse, as we
often come across behaviour patterns that are stereotypes but also those that
are completely different specifically in pet animals of different species when
reared together .It appears as if the behaviour patterns alter when resources are
plentiful and typical interactions are not that pronounced.

In a nutshell, the zoological garden or a field trip provides an unique
opportunity to study and know about the diverse flora as well as fauna, while
providing the basic inputs of animal survival strategies and of course aspects of
ethology or animal behaviour .




THE ZOOLOGICAL GARDEN, ALIPORE

The Zoological Garden, Alipore (also informally called the Alipore Zoo or
Kolkata Zoo) is India’s oldest formally stated zoological park). It has been open
as a zoo since 1876 and covers 18.811 ha (46.48 acres).

It is probably best known as the home of the Aldabra giant tortoise Adwaita,
who was reputed to have been over 250 years old when he died in 2006. It is
also home to one of the few captive breeding projects involving the Manipur
brow-antlered deer.

Laid out on 45 acres (18 ha) of land, the Calcutta zoo has been unable to
expand or modify its layout for over 50 years, and thus has a rather backdated
plan. It contains a Reptile House (a new one has been built), a Primate House, an
Elephant House, and a Panther
House which opens out onto the
open air enclosures for the lions
and tigers.

The place becomes the most

crowded  during the
winter months which are

the peak tourist season in West
Bengal and footfall includes
visitors from all
over the country. The presence of several migratory birds also attracts visitors
and bird lovers alike.

ZOOLOGICAL GARDEN, ALIPORE. ESTD :1875

It also boasts of a glass-walled enclosure for tigers, the first of its kind in
India. A separate Children's zoo is present, and the central water bodies inside
the zoo grounds attract migratory birds.

The Calcutta Aquarium lies across the street from the zoo, and is affiliated to
the zoo.




LOOKING BACK IN TIME....

The zoo was formally opened in Alipore - a posh Kolkata suburb, and
inaugurated on 1 January 1876 by Edward VII, then Prince of Wales. (Some
reports place the inauguration on an alternate date of 27 December 1875).

The initial stock consisted of the private menagerie of Carl Louis Schwendler
(1838 — 1882), a German electrician who was posted in India for a feasibility
study of electrically lighting Indian Railways stations. Gifts were also accepted
from the general public.

The initial collection consisted of the following animals: African buffalo,
Zanzibar ram domestic sheep, four-horned sheep, hybrid Kashmiri goat, Indian
antelope, Indian gazelle, sambar deer, spotted deer and hog deer.

The mention of Alipore Zoological Garden remains incomplete without the
mention of Rai Bahadur Ram Brahma Sanyal, the first Superintendent of the
garden, who dedicatedly worked towards the improvement and maintenance of
animals in the zoo. His contribution towards the captive breeding carried out at
the zoo became a strong success story in an era when these initiatives were
rarely heard of.

MIGRATORY ATTRACTIONS OF THE KOLKATA ZOOLOGICAL GARDEN

The zoo is also home for wintering migratory birds such as ducks, and sports
a sizeable wetland inside the zoo grounds. Since the zoo is enveloped by urban
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settlements for miles, the zoo wetlands are the only resting spot for some of the
birds and are a focus of conservationists in Kolkata.

However, the number of migratory bird visiting the zoo dropped from
documented highs by over 40% in the winter of 2004-2005. Experts attribute
the causes of the decline to increased pollution, new construction of high-rises
in the area, increasing threats in the summer grounds of the birds and declining
quality of the water bodies at the zoo.

We, the students of the Zoology advanced 6th semester visited the
zoological park as per requirement of our syllabus in June.

DATE OF JOURNEY : 14TH JUNE, 2023

CLIMATIC CONDITIONS :

O TEMPERATURE : 37°C
O PRECIP CHANCE : 10%

14th June

Head,"Depariment of Zoology ATIESTED
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o rincipal
Sammilani Mahavidyalaya
E.M. Bypass, Baghajatin
Kolkata-700084



OBJECTIVE OF THE VISIT TO ZOOLOGICAL PARK

O To understand the general concepts that govern the manner in
which animals behave throughout their lives i.e. maximizing
‘fitness’ through essential selfish actions.

O To appreciate the range of mechanisms by which animals adapt
to their environmental conditions using behavioural actions.

O To achieve competence in the skills required to conduct
scientifically meaningful studies of animal behaviour.

ANIMAL BEHAVIOUR

Behaviour can be defined as an expressed course of action produced in
organisms in response to stimulus from a given situation. It could simply be
considered as what the animal does. The fundamental explanation of
behavioural activity must begin with a stimulus and end with a response.

Stimulus: Any change in the biotic and abiotic environments capable of
eliciting or causing some sort of reaction or response in a living organism.
Examples include temperature, pressure, radiation, gravity, or activities of other
organisms within the immediate environment.

GENERAL TYPES OF ANIMAL BEHAVIOUR A.STEREOTYPED
BEHAVIOR :

Stereotyped behaviours also called innate or inborn or inherent behaviour,
are repetitive behavioural acts without any apparent adaptive function. A wide
range of animals, from canaries to polar bears to humans can exhibit
stereotypes. Common examples include —

* Crib-biting and wind- sucking in horses,

* Eye-rolling in veal calves,

* Sham-chewing in pigs, and jumping in bank voles,

* Pacing (animal walking in a distinct, unchanging pattern
within its cage),

o/ ATIESTED
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* Inman: Finger tapping, hair-twirling, tapping feet, nail biting,
smoking, organizing, playing sports, and watching TV.

Alternatively, stereotypies in typical infants and toddlers often resemble
behaviors seen in individuals with autism across the lifespan .

CHARACTERISTICS :

O They are complex in origin and are predictable.

O They are initially stimulus dependent.
O They do not results as a consequence of experience.

Cause: caused by artificial environments that do not allow animals to satisfy their
normal behavioural needs.

Modes of stereotyped behavioural pattern:
. Spatial orientation (Kinesis & Taxis)
. Reflexes

1
2
3. Instincts
4. Motivation

1. ORIENTATION :

Orientation can be defined as special adjustment of animals in response to
various stimuli. It involves single animal. Orientation is of two types- Kinesis and

Taxis.

TAXIS

The motion or orientation of a cell , organism, or a part in response to
external stimulus. It’s a directional movement, locomotion or movement may be
towards (positive taxis), away from (negative taxis) or at a fixed angle to the
source of the stimuli.

TYPES OF TAXIS:
PHOTOTAXIS :

ATIESTED
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Oriented locomotary movement caused by the light either towards a source
or away from it is called phototaxis. E.g. Euglena .

THERMOTAXIS :

The response of animals to temperature is known as Thermotaxis. Animals
thrive to remain in an optimum temperature range. E.g. Paramecium (24-280C),
Amoeba (20-250C) which is a positive thermotaxis.

An avoiding reaction (negative thermotaxis) is shown to temperature higher
or lower than this.

CHEMOTAXIS : Animals showing response to the chemical substances is called
chemotaxis. It is negative in most of the cases. E.g. Amoeba shows negative
chemotaxis to strong solutions of alkalis and to sugars.

GEOTAXIS :

Animal’s response to gravity is called geotaxis.

Some of the animals show negative responses to gravity while other show
positive response. E.g Amoeba exhibits mostly positive response at it drops to

the bottom of the container filled with water whereas Paramecium shows
negative geotaxis.

RHEOTAXIS :

Response to current of air or water is called rheotaxis.

Some of the fish are also positively rheotactic. E.g. Trouts living in stream, not
swept away by the water current. In winds, birds and insects mostly fly upward
although they may go in any direction.

THIGMOTAXIS :

Response to contact or touch is called thigmotaxis.

ATTESTED
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Paramecium when moves slowly and comes in contact with any object like algae
or a plant stem, becomes quiet. However, it shows an avoiding reaction when its
anterior end is strongly touched with a solid object.

GALVANOTAXIS OR ELECTROTAXIS :

Movement of an organism or any of its parts in a particular direction in
response to an electric current is called galvanotaxis or electrotaxis. In positive
galvanotaxis, animals move towards the negative pole or cathode when a weak
electric current is supplied. E.g. Paramecium, when exposed to weak electric
current moves towards cathode.

HYDROTAXIS :

Movement (of an organism or organ) in response to water. An earthworm
moving towards moisture to avoid desiccation is positive hydrotaxis.

Periwinkles move up the shore as the tide rises, maintaining their position
relative to water, to avoid exposure to seawater showing negative hydrotaxis .

KINESIS

Kinesis is the undirected movement in response to a stimulus, which can
include orthokinesis (related to speed) or klinokinesis (related to turning). In
kinesis, an organism changes its movement in a non-directional way—e.g.,
speeding up or slowing down—in response to a cue. Kinesis is directionally not
oriented, i.e. the movement can be in any direction or may be at random.
E.g.woodlice move faster in response to temperatures that are higher or lower
than their preferred range.

TYPES OF KINESIS :
ORTHOKINESIS :

Orthokinesis is a form of kinesis in which the speed of movement of the
individual depends upon the intensity of the stimulus. An increase in the speed
of movement is a positive orthokinesis whereas a decrease in the speed is
referred to as negative orthokinesis.

ATTESTED
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E.g. woodlice , increase their speed of movement when exposed to high or
low temperature.

KLINOKINESIS :

It is another type of Kinesis where the rate of turning or frequency is directly
proportional to stimulus intensity.

2. REFLEXES :

A reflex is an involuntary and relatively stereotyped response to a specific
sensory stimulus. Two features of the sensory stimulus are particularly important
in shaping the reflex response. First, the precise location of the stimulus
determines in a fixed way the particular muscle that contract to produce the
reflex response.

3. INSTINCT / INNATE AND BEHAVIOR :

Instinctive or innate behaviors that are closely controlled by genes with little
or no environmental influence that occur naturally in all members of a species
whenever they are exposed to a certain stimulus. It not learned or  practiced.
An instinct is the ability of an animal to perform a behaviour the first time it is
exposed to the proper stimulus.

B. LEARNED BEHAVIOUR :

Learned behaviour are not under genetic control and occur by exposure to
stimulus form environmental that occur by exposure to the stimulus without any
genetic control .There are neither rigid or flexible and can alter with change of
stimulus and modified to suit changing conditions. Such behaviours increase
adoptability. E.g.- playing of young animals , gorilla using a walking stick,
Japanese macaques using hot water springs in winter to keep warm, crows
using tools for food collection, rats avoiding electric shock in a maze, problem
solving, etc.

ATTESTED
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A fixed action pattern is an instinctive behavioural sequence that is highly
stereotyped and species-characteristic. Fixed action patterns are said to be
produced by the innate releasing mechanism, a “hard-wired” neural network, in
response to a sign/key stimulus or releaser.

Characters —

O It is same in all members of a species .

O The behaviour is performed correctly even the first time without any
experience.

O It is stimulated by a sign acting as stimulus .

O Once started, it will complete without any pauses.

E.g. - Egg rolling reflex by greylag geese.

HABITUATION :

Habituation is defined as a decrement in response as a result of repeated
stimulation not due to peripheral processes like receptor adaptation or muscular
fatigue. Habituation is a form of behavioural plasticity that results in an animal
learning to ignore repetitive stimuli in its environment, allowing it to focus
attention on potentially more relevant stimuli.

E.g.- Squirrels in a park can be initially sensitive to presence of human beings
closely, but with time, it becomes habituated to the human presence except in
close encounters.

IMPRINTING :

According to Hess, E.H. (1959), imprinting is the early practical experience in
life that determines the social imprints, attitudes, and behaviour of biological
organisms in their latter parts of life.

It can be explained as a method by which the environment interacts with
heredity involving . According to Konrad Lorenz (1935), imprinting is the principle
of attachment between a newly born organism and its caretaker.

ATIESTED
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The input here is a stimuli, while the output is the response of that organism
to that specific stimuli. This interaction is not witnessed all through life, but in a
defined “critical period”.

APPROACHES TO BEHAVIOURAL STUDIES

I.  VITALISTIC APPROACH

Behavioural activities are explained in terms of what animals are seen
to do in relation to changes in the environment. It involves total rejection of any
study of the animal outside its natural environment. The technique is
nonscientific since all the observations relate to past events which cannot be
tested experimentally.

II. MECHANISTIC APPROACH

It is an experimental approach and involves the study of particular
aspects of behaviour under controlled conditions in a laboratory. It was
pioneered by Paviov and used extensively in psychological study. It may be
criticized on the basis of the artificiality of the experimental conditions and the
way in which results are interpreted.

II. ETHOLOGICAL APPROACH

Ethology is the scientific study of animal behaviour. It explains responses
observed in the field in terms of stimuli eliciting the behaviour. This was
pioneered by Lorenz, von Frisch and Tinbergen. Ethnologists have so far tried to
answer questions about animal behaviour from such studies.

ESTED
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ANIMAL BEHAVIOUR IN CONFINEMENT OR ZOOLOGICAL
GARDENS

Animals have evolved over millennia and their physical, physiological and
behavioural traits are specifically adapted to their natural habitat.

However, life in captivity differs substantially from life in the wild. Space,
social interactions, diet, climate, presence of humans and many more aspects of
their life may be completely alien compared to what they would encounter in
the wild. Captive animals cannot choose their environment, or carry out
behaviours necessary to enhance their welfare or survival.

Rather than having a safe and easy life in captivity, animals may face a
number of challenges which evolution has not prepared them for. This can result
in Zoochosis, a phrase used to describe the stereotypic behaviour that is
exhibited by captive animals.

Z0OCHOSIS

If the captive environment does not fully cater for the species-specific
needs of an animal, or if it imposes unnatural stress or frustration, there can be
deterioration in the animal’s physical and mental health. This may manifest in
the development of physical disease or abnormal behaviour.

_ A = — -

1992, Bill Travers MBE, Co-Founder of Born Free, first coined the term
'zoochosis' to describe this obsessive, repetitive behaviour, and described
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zoo animals behaving abnormally as 'zoochotic'.

Abnormal behaviour in captive animals can include stereotypic behaviours
— highly repetitive, invariant, functionless behaviour, such as repetitive pacing,
swaying, head-bobbing, bar-biting, over-grooming or excessive licking. These
behaviours result from “the frustration of natural behaviour patterns, impaired
brain function, or repeated attempts to deal with some problem”.

TYPES OF ZOOCHOSIS :
PACING & CIRCLING

Continuous walking back and forth
or in a circle, following the same path.
Signs of regular pacing include definite
paths worn in the ground.

Seen in many captive animals,
especially big cats and canids (for
example, wolves).

Pacing & circling

TONGUE-PLAYING & BAR-BITING

The continual licking, sucking or
biting of walls, bars or gates in an

enclosure. Often seen in giraffe and

primates.
Tongue-playing & bar-biting
NECK-TWISTING ATTESTED
Head, ¥epariment of Zoclogy
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Unnatural twisting and rolling of the neck,
often flicking the head around or bending the
neck back. It is often combined with pacing
~ behaviour.

Seen in, for example, giraffe, llama, bears and
L. primates.

Neck twisting

HEAD-BOBBING, WEAVING & SWAYING

Standing in one place swaying the
head and shoulders — even the whole
body — from side to side. Moving the
¥ head up and down, or weaving to and
! from continuously.

Seen in, for example, bears and
elephants.

Head bobbing. weaving and swaying

ROCKING

Sitting, sometimes hugging the legs, rocking forwards and backwards. Seen in,
for example, captive ape species.

OVER-GROOMING & SELF-MUTILATION

<+

Self-inflicted physical harm such as
biting for chewing tail or leg, or hitting a
head against a wall. Grooming to an
excessive extent, pulling out hair or
feathers, often leaving bald patches,
irritated and broken skin. Seen in, for
example, apes, bears, parrots and big cats.
Over-grooming and self -mutilation
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VOMITING & REGURGITATING

A form of bulimia, the repeated vomiting, eating of vomit and regurgitation.

May be linked to the captive diet. Seen in, for example, captive ape species.

COPROPHILIA & COPROPHAGIA

Playing with and eating excrement (in
species that do not naturally do this) or
smearing faeces on enclosure walls and
glass.

Seen in, for example, captive
primate species.

Coprophilia and Coprophagia

CAPTIVITY SUPPRESSES THE NATURAL INSTINCTS OF
WILD ANIMALS

Animals suffer permanent frustration because they have no freedom of
choice and cannot behave as they would do in their natural environment. This
leads to a tendency toward genetic, physical and behavioural degeneration. In
the wild, an animal’s stress-response system helps it escape from danger. But
captivity traps animals with almost no control over their environment.

These situations foster learned helplessness, negatively impacting the
hippocampus, which handles memory functions, and the amygdala, which
processes emotions.

EHTOGRAM

An ethogram is a primary tool in ethology. Ethology is a zoological,
evolutionary approach to animal behaviour that includes examination, generally
under natural conditions, of the proximate causes and development of
behaviour as well as the ultimate evolution and adaptive value. ATTESTED
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The ethogram is a catalogue or dictionary of the discrete behaviors typically
employed by a species. The included behaviors are sufficiently stereotyped that
an observer may record the number of acts, or the amount of time engaged in
the behaviors.

The ethogram may include drawings (or photographs) in addition to a written
description of each discrete behaviour. In an ethogram, behaviors are described
without explicit reference to their purpose. For example, although a specific
movement may represent a putative threat display it should be given an
objective name such as “head forward” or “bracing display”, and not “head
forward threat” or “bracing threat”.

The definition of the display as a component of antagonistic interactions
arises from the context and surrounding behaviors in which the display is
observed. Ethograms often represent an early stage of investigating the
behaviors of a species and the contexts in which they occur, but may also be the
basis of formal scientific research.

In the early years of animal behaviour, the primary goal of many studies was
the description of behaviour. Although complete ethograms are rarely published
anymore in behaviour literature, they are often used by zoos to describe normal
behaviour and monitor captive behaviour in order to identify pathology due to
illness or poor animal care.

Ethograms also serve as a valuable tool for many lab and field experiments
on both model organisms and ecological studies .As a tool the ethogram usually
describes only a small portion of the complete behavioural repertoire.

Ethograms can be used to detect the occurrence or prevalence of abnormal
behaviours (e.g. stereotypies, feather pecking, tail-biting), normal behaviours
(e.g. comfort behaviours), departures from the ethogram of ancestral species
and the behaviour of captive animals upon release into a natural environment.

The zoo setting also offers the possibility to repeatedly obtain physiological
measures or hormone samples from the same individual, making captive
animals a great resource for understanding animal biology.

METHOD OF PREPARING AN ETHOGRAM




Deciding upon the list of behaviors to record, or ethogram, there are some
general principles to follow. These primarily apply to recording behaviors using
interval and continuous methods but are helpful to consider for any sampling
approach.

O Behaviors should be mutually exclusive:
When recording behaviour, the observer should only be recording one

behaviour at a time. If an animal is performing several behaviors,
for instance walking and eating, the observer needs to define
which behaviour is the more important to record and stay
consistent with that priority.

O Behaviour list should be exhaustive :
The observer should always be able to score something and should never
intentionally leave missing values when recording behaviour. This can
frequently happen when animals go out of sight or perform a behaviour
not previously defined. To address this, the observer should include other
and not Visible choices in the ethogram.

O Behaviour definitions should be objective :
Defining the behaviour should be primarily based on the physical
description of behaviour and not on the perceived (and potentially
subjective) context. Even play behaviors, which often appear similar to
hunting or social behaviors, typically have subtle physical differences to
distinguish these contexts.

DEFINING BEHAVIOUR CATEGORIES

It is helpful to define broad behaviour categories to conceptually group an
ethogram. Ethogram generally includes Inactive, Feeding/ Foraging/ Drinking,
Locomotion, Undesirable, Other Solitary, Social, and Not Visible.

Behaviour categories can be helpful for highlighting relationships between
different types of behaviors and making an ethogram with many behaviors feel
more manageable. In addition, the observer might need to add or remove
behaviors during the study. In order to study and create the ethogram we used
the following behaviour lists for different animals studied.

E.M. Bypass, Baghajatin
Kolkata-700034



ANIMAL SELECTED FOR ETHOLOGICAL STUDY

DISTRIBUTION: South western Angola Namibia and South Africa. HABITAT: They occur in a
variety of habitats such as grasslands savannas woodlands thorny scrublands mountains an
coastal hills.

BEHAVIOUR AND FOOD HABIT: They are generally social animals that live in small
harems to large herds. Zebras communicate with each other with high-pitched barks and
whinnying. The unique stripes of zebras make them one of the animals most familiar to
people. Their diet consists of grasses, but they may occasionally eat shrubs, herbs, twigs,
leaves and bark.

FOOD SERVED: Soaked gram soaked maize crushed maize vegetables mixture of pumpkin
onion and garlic.

BRIEF DESCRIPTION:

1 BODY LENGTH-2t0 2.6 m

2. BODY WEIGHT-350 kg

3. BODY COLOUR-Body with back ground colour is black with white stripes.
LIFE-SPAN: About 23 years.

THREAT: Habitat loss due to ranching and farming and competition for water with
livestock. They are also hunted for their skins.

CONSERVATION STATUS: Exotic mammal. IUCN Red List 2016 3.1
Vulnerable.

BEHAVIOUR SELECTION
BASIC TEMPLATE FOR PATTERNS OF BEHAVIOUR FOR STUDY
ATIESTED
incipal

Sammilan Mahavidygiaya
E.M. Bypass, Baghajatin
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IN ANIMALS

Type of Behavior Code | Description of Behavior

Behavior

Solirary Sleep S Ammal assumes species-specific position for sleep. stays in one place and 1s
not alert to environmental changes.

Rest R Animal stays in one place but may be roused easily by environmental
changes.

Groom Self GS Animal engages in washing or smoothing its own fur or hair using tongue or
forelimbs.

Mantenance M Animal urinates or defecates.

Travel i g Ammal moves from place to place.

Food Eat o Animal consumes food it finds in its environment.
Related

Dnnk D Animal consumes water or other liquids found in its environment.

Look for Food |LF Animal searches the environment for food items.

Social Groom Others | GO Animal engages in washing or smoothing the fur or hair of another animal
in its environment.

Play P Amimal engages in interactions with other that may involve locomotion.
climbing. manipulating objects or other activities that show a relationship
between two or more interacting animals.

Contact C Ammal comes in contact with another animal while engaging in a solitary
behavior.

Ageressive Fight F Animal engages in physical conflict with another animal in its environment.

Steal Food SF Animal approaches another animal that has located food in the environment
and either by physical force or distraction. removed that food item from the
vicinity of the other anunal.

Off Exhibir Off Exhibit O Amimal 1s not visible in exhibit.

BEHAVIOUR CHARACTERISTICS TEMPLATE FOR STUDY OF

ZEBRA AND BEHAVIOUR

Movement from one location 10 another and excludes locomotor play

Active Locomote
Non-
Forage

Bend

Stand Alent

Stand Non-Alert

Play

Social Positive

Social Negative

Explore/Interact
Enrichment
Explore/Interact
Environment

Self-Mainenance

Animal lowers head to the ground for drinking. grazing, or investigating items on the ground

Animal is standing in one position, head is up and attentive to surroundings

Animal is standing in one position. bead is up or down, but eves are closed and animal is nol paying
attention 1o surroundings

Animal is engaging in social (e.g.. chasing). solitary (e.g.. jumping/bucking) or object play (e.g.,
playing w/ object)

Animal is engaging in grooming or affiliative contact with another individual

Animal is engaging in head butt, head slap, kick or stomp behavior including chasing if preceded or
followed by another aggressive behavior

Licking (for less than 5 seconds), sniffing, manipulating enrichment object (non-permanent, non-

food) within the exhibit

Licking (for less than 5 seconds), sniffing, manipulating environment including urineffeces but not
including enrichment (non-permanent, non-food)

Ammal s engaging in grooming self, urinating or defecatng: includes rubbing against exhibit
features

Head, artment of Zeology
Samm#Aani Mahavidyalaya
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STUDY OF ZOOCHRONY IN ZEBRA (Equus bruchelli)

In order to study the captive behaviour we selected the Equus
brucheli as the subject of study and began our observations based on
the behaviour template as provided.

We arrived at the Zoological Gardens Alipore at 9.00 a.m. in the
morning and moved out to the area of the animal to be observed. At
first we went to the Zebra enclosure for behavioural study.

There were a few spectators outside the cage, approximately 10
visitors.

There were 3 Zebras who walking inside the enclosure and doing

many activities. There were several trees in the enclosure. The trees

were full of leaves. They wandered around the trees for a while and
licked the trees. They ate grasses. Then they were drinking water, due

to they were feeling thirsty, because of the heat.

In that mid time when they were moving around the whole area
they show many behaviour like parental care, locomotion, playing,
neck bending, sniffing, engaging with other and licking the net of the

enclosure.

We documented the observed behaviours in an ethogram.
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DISCUSSION AND INTERPRETATION

In the course of animal behaviour in the zoo, we observed different animal’s
ad their stereotypes behaviour according to the behaviour templates. We could
not observe a diverse range of animals and document their behaviours due to
time constrains and other logistic and technical factors but were concentrated
on the four observational animals namely the helmeted curassow, Zebra, Giraffe
and the Swamp deer.

We tried to document their behaviour on the basis of the behaviour
templates and enlist the different types on an ethogram. From a observational
point of view, we have tried to develop a null hypothesis and also an alternate
hypothesis for the cause of the behaviours we have observed.

We can consider a Null hypothesis like the following that the animal
behaviours observed in the zoo are same as the natural behaviour of the animals
observed .In contrast, the alternate hypothesis would be that the animal
behaviours observed in the zoo are partially different from natural behaviour of
the animals observed and reflect the impact of confinement showing zoochosis.

However, if we consider the behaviour patterns that were observed in the
four different animals, it did speak for natural behaviours like walking, running,
resting, grooming that are solitary in nature .In addition to these we also found
feeding and drinking behaviour, as well as play contact, grooming and specially
we were fortunate to observe parental care in both cases of giraffe as well as
zebra .

Suchobservations seems to indicate in favour of the null hypothesis, but
analysing deeply ,we also found stereotypic behaviours like licking the railings
with the tongue, rubbing the head against the railing, which point out towards
change from normal behaviour from wild. We were in no position to experiment
to prove anything, but it appears that at least such changed behaviours do
appear to support the alternate hypothesis and occurrence of zoochosis.

fincipal
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STUDY OF ZOOCHRONY IN ZEBRA (Equus bruchelli)

In order to study the captive behaviour we selected the Equus
brucheli as the subject of study and began our observations based on
the behaviour template as provided.

We arrived at the Zoological Gardens Alipore at 9.00 a.m. in the
morning and moved out to the area of the animal to be observed. At
first we went to the Zebra enclosure for behavioural study.

There were a few spectators outside the cage, approximately 10
visitors.

There were 3 Zebras who walking inside the enclosure and doing
many activities. There were several trees in the enclosure. The trees

were full of leaves. They wandered around the trees for a while and
licked the trees. They ate grasses. Then they were drinking water, due

to they were feeling thirsty, because of the heat.

In that mid time when they were moving around the whole area
they show many behaviour like parental care, locomotion, playing,
neck bending, sniffing, engaging with other and licking the net of the

enclosure.

We documented the observed behaviours in an ethogram.

H ead%of Zoology
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DISCUSSION AND INTERPRETATION

In the course of animal behaviour in the zoo, we observed different animal’s
ad their stereotypes behaviour according to the behaviour templates. We could
not observe a diverse range of animals and document their behaviours due to
time constrains and other logistic and technical factors but were concentrated
on the four observational animals namely the helmeted curassow, Zebra, Giraffe
and the Swamp deer.

We tried to document their behaviour on the basis of the behaviour
templates and enlist the different types on an ethogram. From a observational
point of view, we have tried to develop a null hypothesis and also an alternate
hypothesis for the cause of the behaviours we have observed.

We can consider a Null hypothesis like the following that the animal
behaviours observed in the zoo are same as the natural behaviour of the animals
observed .In contrast, the alternate hypothesis would be that the animal
behaviours observed in the zoo are partially different from natural behaviour of
the animals observed and reflect the impact of confinement showing zoochosis.

However, if we consider the behaviour patterns that were observed in the
four different animals, it did speak for natural behaviours like walking, running,
resting, grooming that are solitary in nature .In addition to these we also found
feeding and drinking behaviour, as well as play contact, grooming and specially
we were fortunate to observe parental care in both cases of giraffe as well as
zebra .

Suchobservations seems to indicate in favour of the null hypothesis, but
analysing deeply ,we also found stereotypic behaviours like licking the railings
with the tongue, rubbing the head against the railing, which point out towards
change from normal behaviour from wild. We were in no position to experiment
to prove anything, but it appears that at least such changed behaviours do
appear to support the alternate hypothesis and occurrence of zoochosis.

ATTESTED

Hea artment of Zoology
Sammilani Mahavidyalaya

Principal

SammMani Mahaviayzlaya
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( NAAC ACCREDITED B++ )

Phone : 2462-6869
E-mail :
principal.sammalani@gmail.com

info@sammilanimahavidyalaya.org

Website :

[AFFILIATED TO CALCUTTA UNIVERSITY]
E. M. BYPASS, BAGHAJATIN,
KOLKATA - 700 094

NOTICE

Students of B. Com. Semester VI are being directed to carefully note the following information for enrolment in
the One Month Internship Programme and Training on Computerised Accounting with Tally Prime and e-filing of
Income Tax and GST Returns, arranged by the Department of Commerce in collaboration
Computer Accountants (ICA). Certificates will be given to all students on successful completion of the Programme
and Training. Enrolment in the Programme and regular attendance in the Training classes is mandatory for Hons.

students.

Classes will be held at:

www.sammilanimahavidyalaya.org

29/1/1, Raja S. C. Mallick Road, Kolkata-700032 at Sukanta Setu crossing or Sulekha crossing near Lokenath

Baba Mandir beside Shyamapalli Shyamasangha Club

Contact person:
Mr. Tapas Kumar Hudait (#9088011066)

Document required for enrolment:
Photocopy of Aadhaar card

Enroiment fees:

Rs. 200/- (Rupees Two hundred only) to be paid in cash only at the time of enrolment on May 08, 2023

«** gnrolment will be done on Monday, May 08, 2023 from 11:30 a.m. to 2:00 p.m. in the

Department of Commerce ***

Princinal
Sgmmilani Mahavidyalaya
E.M.Bypass, Baghajatin
Kolkata - 700 094
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Head
Department of Commerce

Head
Depariment of Commerce
Sammilani Mahavidyalaya
Baghajatin, E.M. By-Pass, Kolxata-34

Syl doo K
Dr. Sharmila Chakraborld
Teacher-in-Charge

Teacher-ln-Chargeé
sammilani Mahavidyalaya
E.M. Bypass, Baghajatin

Kolkata-70
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g ; ¢ Phone : 2462-6869 =
Sammilani Mahavidyalaya 26869

principal.sammalani@gmail.com
{ HAAC ACCREDIIED Bes) info@sumnﬁnimahav%galaya.org
[AFFILIATED TO CALCUTTA UNIVERSITY] i Website :
E. M. BYPASS, BAGHAJATIN, www.sammilanimahavidyalaya.org =
KOLKATA - 700 094 -
12.04.2022
Ref No DAt ... oo s
Notice
A meeting of the Internal Quality Assurance Cell (IQAC) will be held on Tuesday, April 19, 2022 at
2.30 p.m. in the IQAC Room to consider the agenda mentioned below. All the esteemed
members are requested to attend the meeting at the appointed time and date. 3
1. Confirmation of the minutes of the first meeting of the reconstituted IQAC held on 7' _r
February 2022. L
2. Report of the Coordinator on the progress of AQAR 2020-21 preparation including status i
of different criteria as submitted by the respective Advisors and team members, for ;
submission to NAAC within 15.05.2022.
3. More collaborations/linkages with Academia and Industry through signing of MoU. %
4. Procurement of various e-journals, e-books and e-resource in the library of the college. —4

5. Introducing of Green Audit and Energy Audit in the college.

6. Procurement of branded computers with original operating system and a projector for

IQAC room.

7. Miscellaneous, if any.

- ok Welou o NN .,..i ,
= Dr. Srikanta Malakar Dr. Sharmila ChaRraborty

- (Coordinator, IQAC) (Teacher-in-Charge)
Coordinator Teacher-in-Charge
IQAC Sammilani Mahavidyalaya
Samumilani wavidyalayz E.M. Bypass, Baghajatin
— E. M. By Pass, Baghajatis Kolkata-700094

Kolkata-7
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Phone : 2462-6869

E-mail :
principal.sammalani@gmail.com
info@sammilanimahavidyalaya.org
Website :
www.sammilanimahavidyalaya.org

Sammilani Mahavidyalaya

( NAAC ACCREDITED B++)

[AFFILIATED TO CALCUTTA UNIVERSITY]
E. M. BYPASS, BAGHAJATIN,
KOLKATA - 700 094

Minutes of the second meeting of the IQAC held on Monday, 19" April, 2022 at
2.30 p.m. in the IQAC Room

The meeting commenced with the Teacher-in-Charge taking the chair..The agenda were taken up for

discussion one by one and the following resolutions were adopted.

1. The minutes of the last meeting held on 07.02.2022 were read and confirmed.

2. Dr. Srikanta Malakar, Coordinator of the IQAC, reported on the progress of AQAR 2020-21
preparation including status of different criteria as submitted by the respective Advisors and
team members, for submission to NAAC within 15.05.2022. He expressed his hope that the

AQAR 2020-21 would be submitted within the stipulated time.

After a thorough discussion regarding the progress in preparing the AQAR 2020-21, the
members expressed their satisfaction and appreciated the Coordinator for his leadership. It
was resolved unanimously that the Coordinator be requested to carry on with the diligent

effort so that the submission of AQAR 2020-21 might be done within the stipulated time.

3. The members agreed to the proposal of the Coordinator regarding the necessity of more
collaborations/linkages for Faculty exchange, Student exchange, Internship of students, Field

trip, On-the- job training, Research, etc. with Academia as well as Industry, and resolved that

the Teacher-in-Charge be requested to take necessary initiative in this regard including .

signing of Memorandum of Understanding (MoU) with other institutions/industry, wherever

required.
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; 4. Resolved unanimously that the proposal of Dr. Bapan Kumar Maity, Librarian of the college,
:# for procurement of various e-journals, e-books and e-resources in the library, be approved
_&. and he be entrustéd with the responsibility of carrying out the procurement process.

5. Resolved unanimously that conducting Green Audit, Energy Audit, Water Audit and
Environment Audit in the college, be approved and Sri Debasish Roy, Head, the Department
B | of Zoology, be requested to initiate the necessary process as soon as possible.
| 6. Resolved unanimously that the procurement of two branded desktop computers with
= | original operating system and a projector for the IQAC room, be approved; and Dr. Malay
| Roy, Bursar of the college, be entrusted with the responsibility of carrying out the
e procurement process.
¥ 7. Resolved unanimously that the proposal of Sri Nimal Kumar Samanta, He;ldmaster, Ghutiari
= Sharif B M Vidyapith (HS) and an external member in the IQAC, of opening a new YouTube
Bl Channel of the college for uploading college-related audio, video, webinars, etc., be
approved,
? .
As there was no other agendum to discuss, the meeting ended with a vote of thanks to the chair.

" Dr. Srikanta Malakar

S UK

Dr. Sharmila Chakrab

— (Coordinator, IQAC) (Teacher-in-Charge)

| s f'_'g\;_;.‘l‘.fh.ﬂﬂf(}f B
IQAC teacner-in-Chs
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06.06.2022

Report of the Coordinator regarding compliances to the Resolution adopted in the

1.

IQAC Meeting held on 19.04.2022

Memoranda of Understanding (MdUs) with Institutions of national, international
importance, other universities, industries, corporate houses etc. have been going on. The
Department of Commerce has-signed a MoU with Institute of Computer Accountants
Edu. Skills Pvt. Ltd, (Jadavpur), 29/1/1 Raja S.C Mallick, Kolkata- 700032 to facilitate
“Training in Computerised Acqounting (Tally ERP 9), e-filing of GST & Income Tax Returns,
and Related Skill Development; and Internship” for the students of B. Com. Stream of the
college.

One Month Internship Programme and Training on Computerised Accounting with Tally
Prime and e-filing of Income Tax and GST Returns, arranged by the Department of
Commerce in collaboration with the Institute of Computer Accountants (ICA), has
commenced on 12.05.2022 and will contin ue till 10.06.2022.

Procurement of various e-journals, e-books and e-resources in the library of the college
has been entrusted to Dr. Bapan Kumar Maity, Librarian of the college. ‘

The process for conducting Green Audit, Energy Audit, Water Audit and Environment
Audit in the college has already been initiated and Sri Debasish Roy, Head, the
Department of Zoology, has been entrusted with the job.

Procurement process for one branded computer with original operating system for the
IQAC [Resolution no. l(f}' of the Finance Sub-committee meeting held on 05.05.2022] has

already been initiated and Dr. Malay Roy, Bursar has been assigned the responsibility.

Qs Mlowpy | Sl

Dr. Srikanta Malakar Dr. Sharmila Chakrabdfty
(Coordinator, IQAC) (Teacher-in-Charge)
Coordinatar Teacher-In-Charge
IQAC

Sarumilani Mahavidvalaya
‘v Pass, Baghajatin
“olReta-T00 094

E. M
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Sammilani Maha vidyalayz
E.M. Bypass, Baghajatin
Folkata-700094
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